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Help 

About Wiley CulinarE-Companion™ 

Designed to support chefs throughout their careers, Wiley CulinarE-Companion™ Recipe Management Software 
accompanies Professional Cooking, by Wayne Gisslen; Professional Baking, by Wayne Gisslen, and Professional 
Garde Manger, by Lou Sackett, Jaclyn Pestka, and Contributing Author Wayne Gisslen. 

Wiley CulinarE-Companion™ includes all of the recipes from the textbook you are using plus bonus recipes, audio 
pronunciations, illustrated procedures, and technique videos, as well as the ability to create shopping lists, resize 
recipes, perform metric conversions, and analyze the nutritional content of ingredients and recipes. You may even add 
your own recipes, photos, and videos, and create your own cookbooks. 

Note: Only the recipes, procedures, images, and technique videos from the textbook(s) associated with your 
registration card(s) will be added to the Wiley CulinarE-Companion™ database when you download the software. 

System Requirements 

This software is supported on the following platforms: 

PC System Requirements 

Minimum configuration: 

  Pentium IV 
    1024 MB RAM 
    Windows XP, Windows Vista, Windows 2003 Server (for Network version) 
    1 GB free hard disk space 
    Internet Explorer 8, Firefox 3 

Preferred configuration: 

  Intel Core processor 
    2048 MB RAM or higher 
    Windows 7, Windows Server 2008 (for Network version) 
    1 GB free hard disk space 
    Internet Explorer 8, Explorer 9, Firefox 3, or Firefox 7 

Mac OS X System Requirements 

Minimum configuration: 

  PowerPC G5 
    1024 MB RAM 
    Mac OS X, version 10.5 
    Safari 3 or Firefox 3 

Preferred configuration: 

  Intel-based Mac 
    2048 MB RAM or higher 
    Mac OS X, version 10.6, 10.7 
    Safari 4, or 5 or Firefox 7 

To run the CulinarE-Companion™ program the following software must be installed on your computer:  

• The Adobe Flash Player plug-in is necessary to view some program features. It is available for free at: 
www.adobe.com/products/flashplayer/  

• The print option requires Adobe Acrobat Reader. If you do not have this program, it is available for free at: 
www.adobe.com/reader.  
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Previously Installed Versions of CulinarE-Companion™ (CEC) 

Note that CEC 4.3 is a significant update of features in CulinarE-Companion™ and may need you to backup your 
personal files from previously installed versions of other CEC. It is a useful safety precaution to back up your files 
anyway for any version before updating, in case anything occurs during installation that may make your files 
unavailable later. However, please check the notes that follow to see if you need to do so for your installed version. 
Under normal circumstances, previously installed versions in the 4.x series will update automatically. 

CEC 3.0 for Professional Baking, 5th edition installed: 

If you have already installed CEC 3.0 for Professional Baking, 5th edition and you have added your own assets 
(recipes, ingredients, shopping lists, etc.) to this version, all of your assets will appear in CEC 4.3 by doing the 
following:  

1. Save all your recipes by selecting them and clicking on the export button and creating an export file.  
2. Uninstall CEC 3.0 completely.  
3. Click the "Download CulinarE-Companion™" link and install the CEC 4.3 CulinarE-Companion Software.  

Please note, you should first "Save" the downloaded software to your computer on any folder and then install it 
by double-clicking the "setupWileyCulinarE-Companion_4.3.exe". The installation process will be interrupted if 
you click the "Run" button first after clicking the "Download" button above.  

4. Run CEC 4.3 for the first time and you will see the Professional Baking, 5e textbook in 4.3 format and all your 
assets appear in the CEC 4.3 software.  

5. Next, click the "Download Professional Baking, 6th edition in 4.3 format" button to install the Professional 
Baking, 6th edition textbook in the 4.3 format.  

6. Run CEC 4.3 again and you will see the Professional Baking, 6e textbook listed under the cookbook listings in 
the CEC 4.3 software.  

CEC 3.0 for Professional Cooking, 6th edition and Professional Baking, 5th edition both installed: 

If you already had CEC 2.0 for Professional Cooking, 6th edition installed and then you upgraded it with CEC 3.0 for 
Professional Baking, 5th edition, then all of your own assets (recipes, ingredients, shopping lists, etc.) are already in the 
CEC 3.0 version. You should then proceed with the steps described above for CEC 3.0 for Professional Baking, 5th 
edition. 

CEC 2.0 for Professional Cooking, 6th edition installed: 

If you already have CEC 2.0 for Professional Cooking, 6th edition installed and you have added your own assets 
(recipes, ingredients, shopping lists, etc.) to this version, please remember that your assets will not automatically 
import from CEC 2.0 to CEC 4.3. You can do the following:  

1. Save all your recipes in CEC 2.0 by exporting them to a file format (pdf, xls, txt).  
2. Uninstall CEC 2.0 completely  
3. Download and install the CEC 4.3, CulinarE-Companion Software.  
4. Run the application and create your assets in CEC4.3 manually again  

If you have any previous versions of CulinarE-Companion already installed on your computer and you have any 
questions or issues, please refer to http://wiley.custhelp.com/app/ and type in "CulinarE-Companion" for additional 
assistance. 

Customer and Technical Support 

This program contains files in both Flash and PDF format. If you do not have a PDF reader or a Flash player installed 
on your computer, you may download the latest readers and players for free at www.adobe.com/downloads.  
If you cannot find the answer to your question in the Help section, please contact us by phone or through online 
support. 
Online: For technical support, please visit the Wiley Customer Support Website at http://wiley.custhelp.com/app/. This 
searchable knowledge base contains FAQs, installation notes, content updates, and more for many of our current 
products. It also enables you to contact a technical support representative directly if you do not find the answer to your 
question. 
By Phone: Call 1-800-762-2974 (U.S.) and 1-317-572-3994 (international) from 8:00am to 8:00pm Eastern time, 
Monday through Friday. 
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INSTALLING AND RUNNING THE PROGRAM 
Installing the program 

• You should be logged in as an administrator or as a user with administrative rights on your system.  
• Make sure that you have enough free disk space available on the drive where you want to install the 

application.  

Step 1: Download and install the CulinarE-Companion 4.3 application before installing any of the book products.  

• Click the Download CulinarE-Companion™ link and install the CEC 4.3 CulinarE-Companion Software. 
Follow the on-screen instructions. 

Note: You should first "Save" the downloaded software to your computer in any folder and then install it by 
double-clicking "setupWileyCulinarE-Companion_4.3.exe". The installation process will be interrupted if you 
click the "Run" button first after clicking the "Download" button. 

Step 2: Download and install the media files for the book you have purchased (Professional Baking, 6th edition; 
Professional Cooking, 7th edition; Professional Garde Manger).  

• Download the setup.exe file for book you have purchased to your computer in any folder and then install it by 
double-clicking. Follow the on-screen instructions.  

• Double-click the Wiley CulinarE-Companion™ 4 icon or the shortcut on your desktop and launch the 
application which will also download and install the media files for any product you have purchased. Media files 
are more than 100MB and may take some time to download. After installing media, the application should open 
to the home page. Installation of media occurs only on the first time you launch the application.  

NETWORK VERSION 
Brief instructions to begin using the application 

To work with the application as a server and to work with several end-users it is necessary to create several login 
records for proposed users within the database. There is one default login record with administrator rights, which 
cannot be modified. The login screen with empty login and password boxes appears after the application starts. Please 
enter "culinarec" for the login, and "culinarec" for the password to start the program. The administrator can register 
new users with the Create new user function. The number of user's stored login records is not limited, but the number 
of concurrent users cannot be more than 100. The administrator can control registry records of all users. 

There are two types of users in the CulinarE-Companion software: user and administrator. An ordinary user can use 
all general functions of the application. The administrator can create and remove registry records of all users and 
change their passwords. To access the application, the administrator should login as an ordinary user (enter "admin" 
for the login, and "admin" for the password). 

The application begins running immediately after presentation of the Start screen, which contains the login and 
password boxes. It is not necessary to enter a login and password in this starting screen to work with the application 
from the end-user's machines. Closing this window on the server machine will stop the application. The administrator 
can create and remove registry records of the users and change their passwords. In the case of de- and re-installation 
of the program, data for all users is retained on the server machine. 

Running the application from an end-user's machine 

For Windows: 

Users can access the Wiley CulinarE-Companion™ Network version via Internet Explorer or Firefox browsers. 

To create the login record on the Server machine:  

1. Run the application.  
2. Enter "culinarec" for the login, and "culinarec" for the password.  
3. Register new user: choose Manage Users, then Create new user, and enter for example: "u1" for the login, 

and "p1" for the password.  
4. Logout.  
5. Give this account to the end-user.  
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To define the address on the Server machine:  

1. Click Start menu and Run...  
2. Type "cmd" and press the "OK" button  
3. Type "ipconfig" and press the "Enter" button  
4. Copy the IP Address of that machine. For example: 111.222.333.444  
5. Run the application or look at the address bar if already open.  
6. Copy the path of the admin program, for example: http://127.0.0.1:33435/culinarec/pub/login  

and replace 127.0.0.1 or localhost with the IP address: http://111.222.333.444:33435/culinarec/pub/login  
7. Give this address to the end-user.  

To run the application from an end-user's machine: 

Please use the login, the password, and the address received from the administrator. 

For example: 

address: http://111.222.333.444:33435/culinarec/pub/login 
login: u1 
password: p1 

For Mac OS: 

Users can access the application via Safari or Firefox browsers. Users can access Wiley CulinarE-Companion™ 4 
Network from any remote terminal using the address received from their administrator. An example of this address is 
http://111.222.333.444:50000/culinarec/pub/login. 

To define that path on the server machine:  

1. Click Apple -> System Preferences -> Network  
2. There will be a list of connections. Choose current connection: Built-in Etherenet Connected.  
3. Find the IP Address at the right.  
4. Copy the IP Address of that machine. For example: 111.222.333.444  
5. Run the application.  
6. Copy the path of the admin program, for example: http://127.0.0.1:50000/culinarec/pub/login 

and replace 127.0.0.1 or localhost with IP address: http://111.222.333.444:50000/culinarec/pub/login  
7. Give this account to end-users.  

TROUBLESHOOTING AND OTHER RECOMMENDATIONS 

The CulinarE-Companion™ application operates as a mini web server on your computer. This is very efficient and 
flexible but may require some adjustments to your browser settings if you have problems at any time. It is unlikely you 
will have problems unless you have altered settings on your browser. The following notes explain the main points 
where a problem may arise. 

Bypass proxy settings 

For Windows: 
If you use a local network with proxy server, you should select the check box "Bypass proxy server for local 
addresses" in your internet settings. Please check for Internet Explorer: Tools -> Internet Options -> Connections -> 
Local Area Network (LAN) Settings -> Proxy server.  

For Mac OS: 
If you use a local network with proxy server, you should go to the System Preferences -> Network -> choose one of 
your internet connections, for example "Build-in Ethernet" -> Proxies tab -> Configure Proxies Manually -> add 
"127.0.0.1" into "Bypass proxy settings for these Hosts & Domains" text box.  
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Disable your pop-up blocker 

If you have a pop-up blocker installed in your web browser, it may interfere with the functioning of the CulinarE-
Companion™ application, which does use pop-ups. Please disable your pop-up blocker while you are using this 
software. 

Browser's security level 

Some pages may trigger an error message if the security settings of your internet browser are set to HIGH. It is 
recommended to set the security level to MEDIUM while running the program. You can also identify this program as a 
safe product for security as follows - for Internet Explorer:  

1. Go to the Tools menu -> Internet Options -> Security tab.  
2. Select "Trusted sites" as a web content zone.  
3. Click "Sites".  
4. Uncheck "Require server verification (https:) for all sites in this zone".  
5. Type "localhost" in the "Add this website to the zone" field and press the "Add" button.  
6. Click "Close".  
7. Set slider "Security level for this zone" to Low.  
8. Click "OK".  

Switching between browsers 

For Windows: 
If both Internet Explorer and Firefox are installed on your system, it is possible to switch the program to use the one of 
your choice. To choose a browser: 

1. Run the application.  
2. Choose "Select" from the "File" menu in the "Wiley CulinarE-Companion 4.3" window.  
3. Select your preferred browser and press the "OK" button.  
4. Close the program, and then restart the application to choose the new browser. 

If only Internet Explorer is available on your system this option is disabled.  

For Mac OS: 
If both Safari and Firefox are installed on your system, it is possible to switch the program to use the one of your 
choice. To choose a browser: 

1. Run the application.  
2. Click "Wiley CulinarE-Companion™ 4" -> "Preferences..." on the top command bar.  
3. Click the "Browser" tab.  
4. Select your preferred browser from the drop-down menu and click "Close". 

If Safari is the only browser available on your system this option is disabled.  

Protected Mode 

To run CulinarE-Companion™ on Windows Vista with Internet Explorer as a user other than an administrator, you must 
disable the Protected Mode in Internet Explorer. To do so, go to the Tools menu -> Internet Options -> Security tab 
and unselect the checkbox "Enable Protected Mode". 

You cannot use more than one session of CulinarE-Companion™ 

If you get the message "You cannot use more than one session of CulinarE-Companion" be sure that all browser's 
windows are closed. 
Choose "Exit" from the "File" menu in the "Wiley CulinarE-Companion 4.3" window to cancel the Wiley Launcher. 
To correct problems with the Wiley Launcher in the Internet Explorer you can do the following:  

1. Start -> Control Panel -> Programs and Features -> Wiley_IEURLlistener -> Uninstall.  
2. Launch Wiley_IEURLlistener.msi from the Wiley CulinarE-Companion 4 directory to install the 

Wiley_IEURLlistener file.  
3. In Internet Explorer -> Tools -> Manage Add-ons -> Toolbars and Extensions -> UrlListenerBHO Class 

should be "Enabled".  
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More than one instance of the Safari 5.1 browser 

If the program opens more than one instance of the Safari 5.1 browser (for example, one browser with a previous 
screen displaying and one browser with the current program running) , you can correct this by making the following 
changes in your preferences:  

1. Safari -> Preferences... -> General tab  
• New windows open with: Empty Page  
• New tabs open with: Empty Page.  
• Homepage: (empty)  

2. Safari -> Empty Cache...  

Two browser windows open up in Macintosh 10.7 with Safari 5.1.1 when launching CulinarE-Companion™ 

When you are using Macintosh 10.7 with Safari 5.1.1, if CulinarE-Companion™ opens two instances of the browser, go 
to System Preferences -> General, and make sure the option "Restore windows when quitting and re-opening 
apps" is checked. When you relaunch the program, only a single Safari browser window will open. 

Procedure PDFs are not loaded in Safari 4 

If you clicked 'Procedures' links in Skills -> Skills Library and the file did not load in the frame as expected, please try 
to do that:  

1. Applications -> Adobe Reader 8 -> Adobe Reader -> Preferences -> Categories: Internet  
2. Clear the checkbox "Display PDF in browser using: ..."  
3. Click "OK".  

Export of Recipes as a Zip-file in Safari 

Before Export of Recipes as a Zip-file in Safari, please do the following:  

1. Safari -> Preferences... -> General  
2. Clear the checkbox "Open "safe" files after downloading".  

ABOUT 

Software Navigation 

 

The main toolbar at the top of each page, allows you to easily navigate through the Wiley CulinarE-Companion™ 
application. 

About: HOME 

 

Whenever the Wiley CulinarE-Companion™ application is launched, it opens to the HOME page. From the HOME 
page, you may link directly to any of the Cookbooks (including cookbooks you create), Recently Viewed Recipes, or 
Technique Videos. A Search recipes and Advanced search function is also available, allowing you to easily search 
recipes by name, related key word, or even the primary cooking method or cuisine. 
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In addition, the HOME page provides links to the Wiley web site where you will be able to find information about 
additional titles by Wayne Gisslen and other Wiley culinary arts publications. 

 

 

About: PREFERENCES 

The Preferences function, located on the upper right hand side of the application under the Wiley logo, allows you to 
update your ingredient amount preference (US, Metric, or Both), change the order of the cookbook titles in the 
application, and add or rename your own cookbook title. 
The application displays, by default, both US and Metric ingredient values, when you select the US, Metric, or All 
button, and you click the SAVE button, the ingredient amount values in the recipe display will change to that selection. 

When you have multiple cookbooks available, you can change their display order in the cookbook selection dropdown 
boxes by selecting the up or down indicator. Click the SAVE button in order to make your selection permanent. To 
create a new cookbook title, enter the cookbook title and author name, click +ADD NEW button, and click the SAVE 
button to save the new cookbook title. To rename a cookbook title, select a title from the drop-down list, enter the new 
cookbook name and author name, click the RENAME button, and click the SAVE button to save this revised cookbook 
title. 

About: RECIPES 

Clicking on the RECIPES tab brings you to the "heart" of the Wiley CulinarE-Companion™ application. From this page, 
you may choose to view recipes, access the nutritional analysis of an ingredient in the Ingredient List, Create or Add 
a New Recipe, or Add a Cookbook. 

Note: Only the recipes, procedures, images, and technique videos from the textbook(s) associated with your 
registration card(s) will be added to the Wiley CulinarE-Companion™ database when you download the software. 

About: SHOPPING LIST 

 

The SHOPPING LIST function allows you to easily create shopping lists automatically from recipes. You can even 
easily generate a combined shopping list from multiple recipes. 

About: SKILLS 

 

The SKILLS tab includes a Skills Library, a Procedures Library, and a Technique Video Library. The Skills 
Library presents a collection of key procedures, recipes, and technique videos organized in a manner that illustrates 
and reinforces core cooking and baking techniques. The Procedures Library is an alphabetical listing of the key 
procedures referenced in the recipes, as well as bonus procedures highlighting fundamental techniques required to 
execute the recipes. The Technique Video Library is an alphabetical listing of all of the video clips in your Wiley 
CulinarE-Companion™ database. 

Note: Only the recipes, procedures, images, and technique videos from the textbook(s) associated with your 
registration card(s) will be added to the Wiley CulinarE-Companion™ database when you download the software. 
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About: TOOLS 

 

The TOOLS tab includes useful reference tables, such as Metric Conversion Factors and Approximate Weight-Volume 
Equivalents for Dry Foods. 

About: GLOSSARY 

 

Wiley CulinarE-Companion's™ GLOSSARY contains over 1,800 culinary terms, with audio pronunciations for over 700 
foreign terms. 

About: MY FILES 

 

MY FILES is where all of your personal recipes, photos, videos, and other documents that you attach to the program 
are organized for easy access. You can classify them so they are easy to find for future reference. You also can easily 
replace and update files as your skills progress. 

About: RECIPE LIST 

 

The Recipe List is an alphabetical listing of all of the recipes included in Wiley CulinarE-Companion™. You can re-sort 
the list by author or revision date. You can also choose to refine the list by clicking any of the options under Refine 
List, such as a primary cooking method or main ingredient. You can also use the drop down menu under Browse 
Recipes to choose a particular cookbook. 

Note: Only the recipes, procedures, images, and technique videos from the textbook(s) associated with your 
registration card(s) will be added to the Wiley CulinarE-Companion™ database when you download the software. 

About: INGREDIENT LIST 

 

The Ingredient List is an alphabetical listing of all of the ingredients in the Wiley CulinarE-Companion™ database. 
Choosing an ingredient allows you to view the nutritional analysis for that ingredient. You may even add new 
ingredients to the database. 

About: RECIPE DETAILS 

 

On this screen, you may view all of the information necessary for a recipe's proper execution: Portion Size, Yield 
Information, Ingredients, Procedures, Notes, and Variations. Under Portion size, the application allows you to 
double or halve the recipe and adjust portion size, as well as convert all measurements into metric. For recipes that 
can be prepared in multiple stages, Wiley CulinarE-Companion™ divides the recipe into its separate Stages. You also 
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can listen to the audio pronunciation of a recipe name (if available) or easily access any cross-referenced procedures 
or recipes by clicking on the applicable hyperlinks. 

About: NUTRITION 

 

The Nutrition tab within each Recipe displays a recipe's nutritional analysis. The Wiley CulinarE-Companion™ 
application calculates the analysis automatically. 

About: IMAGES 

 

From the Images tab within each Recipe, you can view the photo(s) associated with a recipe, if available. You may 
even add your own images. See Add: IMAGE. 

About: VIDEOS 

 

From the Videos tab within each Recipe, you can view the technique video associated with a recipe, if available. You 
may even add your own video clips. See View: TECHNIQUE VIDEO. 

About: CLASSIFY THIS RECIPE 

 

From the Classify This Recipe tab within each Recipe, you can assign or change how an individual recipe is classified 
by the Wiley CulinarE-Companion™ application. Recipe searches and recipe lists - refined by cookbook, category, 
cuisine, main ingredient, primary cooking method, dietary consideration, and dietary restriction - depend upon your 
classifying every recipe you add or edit using the items located in the scroll-down lists on this page. 

See Edit: Classify this Recipe; About: ADVANCED SEARCH / REFINE. 
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About: INGREDIENT LIST 

 

From this page, you may access the nutritional information for the ingredients in the Wiley CulinarE-Companion™ 
application. If there are ingredients that are not included in the database, in certain cases, you may obtain the missing 
nutrient data by clicking on the USDA Nutrient Data Laboratory link and searching the USDA National Nutrient Database, or 
you may add your own information. 

About: ADVANCED SEARCH / REFINE 

 

The recipes included in Wiley CulinarE-Companion™ have been classified by their category, cuisine, main ingredient, 
primary cooking method, dietary consideration, and dietary restrictions. The Refine function on the Recipe List page 
allows you to narrow your search by these classifications. 
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The Advanced search function allows you to narrow your search by multiple classifications, as well as by a key term. 

ADD 

ADD: ATTACH EXISTING RECIPE 

You may add any file that you have saved to your hard drive or other storage device to the Wiley CulinarE-
Companion™ database as a recipe. To attach an existing file, click Attach Existing Recipe under the RECIPES tab 
and follow the instructions to browse and upload a file. On the resulting page you will see the hyperlink to your file in 
the Procedures box at the bottom of the page. Assign a Recipe Name and Author to this file so that you can easily 
locate it later under the MY FILES tab. This file will be saved in the Wiley CulinarE-Companion™ software, in addition 
to still being stored on your storage device. When you open the recipe from the software, the link to the attachment will 
appear in the procedure field. 

 

Add: CLASSIFICATIONS TO A RECIPE 

The Advanced search and Refine functions in Wiley CulinarE-Companion™ depend upon your classifying every 
recipe you add or edit using the classifications located on the Classify This Recipe page. When viewing an individual 
recipe, click the Edit button, then click on the Classify This Recipe tab. You may select as many classifications as you 
like (by checking the corresponding boxes). Before leaving the Classify This Recipe page, make sure to click the 
Save button or Save & Close button in order to make your selections permanent. See Edit: CLASSIFY THIS RECIPE 
CLASSIFICATIONS. 

Note: "Locked classifications" cannot be renamed or deleted because they are associated with the recipes that are 
included with the Wiley CulinarE-Companion™ application. 

Add: COOKBOOK 

There are three ways to add a new cookbook:  

1. Click the RECIPES tab, then click Add Cookbook on the right hand side of the toolbar. On the resulting Add 
New Cookbook page, enter the name and author of the new cookbook in the boxes provided and then click 
the Add New Book button;  

2. When viewing an individual recipe, click the Classify This Recipe tab, then click Edit. Then under Cookbook, 
click the + Edit link. On the resulting pop-up box, enter the name and author of the new cookbook in the boxes 
provided, and then click + Add New. You must click Save before closing the pop-up box in order to save your 
newly added cookbook.  



CulinarE-Companion™ Help 

Copyright © 2012 by John Wiley & Sons, Inc. All Rights Reserved. 12 

3. Click the Preferences link located at the upper right hand corner of each page. A pop-up box will appear. 
Enter the name and author of the new cookbook in the boxes to the right of Enter a new item, and click + Add 
New. You must click Save before closing the pop-up box in order to save your newly added cookbook.  

Add: CREATE RECIPE 

 

By using the Create Recipe feature, you will be able to take advantage of the full range of functionality offered by 
Wiley CulinarE-Companion™, including the nutritional you can choose analysis and shopping list functions. 

Click the Create New Recipe tab under the RECIPES tab. A dialogue box will appear with two options to create a new 
recipe. You may either copy and paste an existing recipe file or fill in a recipe form. 

 

To copy and paste recipe information from an existing MS Word, .TXT, or .RFT file, select the first radio button and 
click Open. Then, follow the instructions on screen and below: 

Step 1: Copy and paste the contents of your recipe document into the "New Recipe" form. Note that your ingredient 
information should be formatted in the following way to insure that they populate the ingredient fields correctly in the 
software: 

a. All quantities should be expressed in decimals, not fractions  
b. Ingredients should be separated by tab, not a space  

For example:  
"1½ cups(space)brown sugar" should be "1.5 cups ->(tab)brown sugar"  

Step 2: Follow the onscreen instructions to highlight specific sections of the recipe with the appropriate letter key.  
Step 3: Click "Next" when you are done.  
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To enter a recipe into a form, click the Create New Recipe tab under the RECIPES tab, and select the second radio 
button: "Fill in the recipe form." You can navigate from entry to entry on the resulting Create/Edit Recipe screen by 
using the Tab button on your keyboard. To input the relevant recipe information:  

1. Enter all new recipe details in the boxes provided, including: Recipe Name, Recipe Author, and Phonetic 
Spelling.  

2. If there is a foreign or other name for this recipe, click Add Alternative Name and type in this information.  
3. Add Portion size and Yield information in decimals, not fractions, and in either US or Metric, or both. The 

application will automatically enter the same unit of measure for Yield as is entered for Portion Size. If you do 
not include the Metric Unit of Measure, the application will calculate this information automatically for you 
after you Save the recipe.  

4. Add additional descriptive information about your recipe in the text box provided below the Portion and Yield 
information.  

5. To display the Baker's % in your recipe if applicable, under the Portion and Yield information, check the box 
labeled Show Baker's %. (See View: BAKER'S %);  

6. To add your recipe to the ingredient list so it can be used as an ingredient in another recipe, check the box 
labeled Add this Recipe to the Ingredient List (See Add: RECIPE TO THE INGREDIENT LIST).  

7. To add Ingredients, Procedures, Notes, and Variations, click the Add Stage link. This function allows you to 
group ingredients and related procedures together as you would during the execution of a recipe. You can add 
as many Stages to a recipe as you want, or you can choose to use only one Stage.  

 

a. To name a Stage, enter a name in the Title field  
b. To add an Ingredient, click the Add Ingredient link and start typing in the ingredient name and the 

application will present a list of possible options. Selecting from these options allows Wiley CulinarE-
Companion™ to calculate the nutritional analysis. If you choose to select an ingredient that is not on 
the list, you will need to add this ingredient to the Ingredient List in order for Wiley CulinarE-
Companion™ to include this ingredient in the nutritional analysis for the recipe. When adding the 
quantity, if you do not include the Metric Unit of Measure, the application will calculate this 
information automatically for you after you Save the recipe. In the preparation field after the ingredient 
name, enter in any information that pertains to how the ingredient should be prepared.  
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c. To create a title for a sub-group of ingredients within a Stage, click Add Sub-Stage Title and add a 
title. Click Add End of Sub-Stage when you finish adding ingredients to this specific group.  

d. To add a Procedure, Notes or Variations click the relevant link and enter information as you would in 
a word processing program, using the formatting buttons - B for bold, I for italic, and U for underline - 
as desired.  

8. Wiley CulinarE-Companion™ will base its nutritional analysis on the ingredients you selected when adding the 
ingredients to your recipes. You may choose to add your own nutritional information by clicking on the 
Nutrition tab and adding the nutrition information.  

9. To add a photo of your finished dish, click the Images tab and upload an image (PNG, JPEG, GIF, BMP files) 
from your hard drive or other storage device. This image will also be saved in your MY FILES.  

10. To add a video clip for this recipe, go to the Videos tab and upload your video as instructed. You can upload 
only FLV files. This video file will also be saved in your MY FILES.  

11. To classify your recipe so it can be found when using the Refine or Advanced Search function, click the 
Classify This Recipe tab and select all classifications that apply.  

Note: A recipe remains "unassigned" until it is associated with a cookbook. You can associate an unassigned recipe on 
the Classify This Recipe page. 

To save your recipe, click the Save button and remain in the existing recipe screen or the Save & Close button if you 
want to exit this recipe and start a new search or add a new recipe. 

Add: IMAGES 

From the Images tab within each Recipe, click the Edit button. Then click the Upload a New Photo link to produce a 
File Upload window, and locate the file you wish to upload (PNG, JPEG, GIF, BMP). 

Note: You cannot add a photo to a Wiley CulinarE-Companion™ recipe unless you save the recipe as a new recipe. 

Add: INGREDIENT (TO INGREDIENT LIST) 

There are two ways you can add an ingredient to the Ingredient List:  

1. When adding a new recipe as part of the CREATE RECIPE function, include an ingredient that is not in the 
auto populated ingredient list. See Add: CREATE RECIPE; or  

2. Under the RECIPES tab, click Ingredient List. On the resulting Ingredient List page, click the + Add New 
Ingredient button. On the resulting Add New Ingredient page, enter the name of the new ingredient you wish 
to add in the Details box. If you know the Nutrition Facts for the new ingredient, enter these in the boxes 
provided. If you do not have all the Nutrition Facts at hand, click the USDA Nutrient Data Laboratory link to 
obtain this information. When you are finished entering all the information for your new ingredient, click the 
Save button.  

Note: If an existing ingredient has the same nutritional information of the ingredient you want to add, you can select the 
existing ingredient (so the nutrition fields are populated) and then add the new ingredient's name. 
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Add: INGREDIENT (TO RECIPE) 

When editing a recipe or creating a new recipe, in the Ingredient field, start typing in the ingredient name and the 
application will present a list of possible options. Selecting from these options allows Wiley CulinarE-Companion™ to 
calculate the nutritional analysis. If you choose to select an ingredient that is not on the list, you will need to add this 
ingredient to the Ingredient List in order for Wiley CulinarE-Companion™ to include this ingredient in the nutritional 
analysis for the recipe. The letter (R) next to an ingredient indicates that the ingredient is a recipe from the database. It 
will appear as an ingredient in your recipe with a hyperlink that will allow you to easily access the cross-referenced 
recipe. When adding the quantity, if you do not include the Metric Unit of Measure, the application will calculate this 
information automatically for you after you Save the recipe. In the preparation field after the ingredient name, enter any 
information that pertains to how the ingredient should be prepared. 

To save your recipe, click the Save button and remain in the existing recipe screen, or click the Save & Close button if 
you want to exit this recipe and start a new search or add a new recipe. See Add: CREATE RECIPE. 

Add: RECIPE 

You can add a new recipe to your Wiley CulinarE-Companion™ database by either creating a new recipe (Create New 
Recipe) or attaching a recipe (Attach Existing Recipe). If you use the Create New Recipe function and input all of 
the necessary information, all of Wiley CulinarE-Companion's™ functionality will be available, such as the Shopping 
List and Nutritional Analysis functionality. If you attach a recipe, this added functionality will not work. See Add: 
CREATE RECIPE; Add: ATTACH EXISTING RECIPE. 

Add: RECIPE TO COOKBOOK 

From the Recipe List page, check the box(es) next to the applicable recipe(s) and then click on + Add to Cookbook. 
In the resulting pop-up box, select the cookbooks to which you would like the recipe added and click Save, then Close. 
Remember to click Save before Close to make your selections permanent. For your personal recipes, you may also 
add cookbook classifications to your recipes by following the directions under Recipe Classifications in the Classify 
This Recipe tab. See About: CLASSIFY THIS RECIPE, Add: CLASSIFICATIONS TO A RECIPE. 

Add: RECIPE TO INGREDIENT LIST 

When you add a new recipe by using the function Create New Recipe, you can also add your new recipe to the 
ingredient list so that it can be used as an ingredient in another recipe. When editing a recipe or creating a new recipe, 
check the box that says Add this Recipe to the Ingredient List. 

 

Add: RECIPE TO A SHOPPING LIST 

There are two ways to add a recipe's ingredients to a shopping list:  

1. From the Recipe List page, check the box(es) next to the desired recipe(s) and then click the + Add To 

Shopping List button. See View: RECIPE - LISTS; or  
2. From the individual recipe page, click the + Add To Shopping List button. See View: RECIPE - INDIVIDUAL  
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From the resulting pop-up screen, select an existing shopping list from the pull-down menu next to the Select a 
shopping list box, or enter the name of a new shopping list in the box next to Create New Shopping List. When 
finished, click the Save button. 

Add: SHOPPING LIST 

Click on the SHOPPING LIST tab and click the + Add New Shopping List button. A pop-up box will appear. Type in 
the name of your shopping list and click Save. 

Add: SHOPPING LIST ITEM 

To add an individual ingredient that is not part of a recipe to a SHOPPING LIST, click on the SHOPPING LIST tab. On 
the resulting Shopping Lists page, select a shopping list. Once you have selected your shopping list, you can type in 
an ingredient name into the Add Item from Ingredient List box or type in new ingredient name into the Add Custom 
Item box. If you select an ingredient from the auto-populated list, this item will be added alphabetically to your shopping 
list. If an ingredient is not available in the auto-populated list, you can add your own ingredient by typing the item name 
into the Add Custom Item box and clicking the + Add button. Click the Save button to make your changes permanent. 

Add: SHOPPING LIST RECIPE 

There are two ways to add a recipe's ingredients to a shopping list:  

1. From the Recipe List view, check the box(es) next to the desired recipe(s) and then click the + Add To 
Shopping List button. See View: RECIPE - LISTS; or.  

2. From the individual Recipe Details page, click the + Add To Shopping List button. See View: RECIPE - 
INDIVIDUAL.)  

From the resulting pop-up screen click on an existing shopping list from the pull-down menu next to the Select a 
shopping list box, or enter the name of a new shopping list in the box next to Create New Shopping List. When 
finished, click the Save button. 

Add: VIDEO 

When in edit mode within each recipe, click the Videos tab. Click Upload a New Video to produce a File Upload 
window. Locate the file you wish to upload. 

Note: You cannot add a video clip to a Wiley CulinarE-Companion™ recipe unless you save the recipe as a new 
recipe. 

Note: Videos must be in *.flv (Flash) format; if your videos are not in Flash format, there are many popular software 
utilities that can convert your file to Flash. It is not advisable to upload files larger than 1 GB. 

DELETE 

Delete: COOKBOOK 

Click the Preferences link located at the upper right hand corner of each page. A pop-up box will appear. To delete a 
cookbook, click the red "X" to the right of the applicable cookbook title. Click Save before Close to make your changes 
permanent. 

Note: Only user added cookbooks may be deleted. 

Delete: INGREDIENT (FROM RECIPE) 

When you are editing a recipe, click the"X" button at the end of the ingredient line to delete it, then click the Save 
button. See Edit: RECIPE. 
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Delete: RECIPE 

From the Recipe List view, check the box(es) next to the recipe(s) you wish to delete, then click the Delete button 
located at the top and bottom of the page. 

Note: Only user added recipes may be deleted. 

Delete: RECIPE (FROM SHOPPING LIST) 

Select the SHOPPING LIST tab. On the resulting Shopping Lists page, check the box(es) next to the recipe(s) you 
wish to edit. On the resulting shopping list page, click the red "X" next to the recipe you wish to delete from the list. 

Delete: SHOPPING LIST 

Select the SHOPPING LIST tab. On the resulting Shopping Lists page, check the box(es) next to the recipe(s) you 
wish to delete, then click the Delete button located at the top and bottom of the page. 

EDIT 

Edit: CLASSIFY THIS RECIPE CATEGORIES 

When viewing an individual recipe, click the Edit button, click on the Classify This Recipe tab, then click the + Edit 
button next to the respective list. A pop-up box will appear called Manage Classifications:  

• To enter a new item, enter the name of the new item in the box and click the + Add New button.  
• To rename a classification, enter the name in the box and click the Rename button.  
• To delete a classification, click the red "X" next to the classification title.  

Click the Close button to return to the previous page. Before leaving the Classify This Recipe page, make sure to 
click the Save button or Save & Close button in order to make your selections permanent. 

Note: "Locked classifications" cannot be renamed or deleted because these are associated with the recipes that are 
included with the Wiley CulinarE-Companion™ application. 

Edit: COOKBOOK ORDER 

Click the Preferences link located at the upper right hand corner of every page. On the resulting pop-up screen, click 
the Edit button next to the cookbook you wish to move. On the resulting pop-up screen, you may Move to Top, Move 
Up, Move Down, Move to Bottom, or Delete a cookbook. Click the Save button. 

Note: Only user added cookbooks may be deleted. 

Edit: COOKBOOK LIST, COOKBOOK NAME OR COOKBOOK AUTHOR 

Click the Preferences link located at the upper right hand corner of each page. A pop-up box will appear:  

• To enter a new cookbook, enter the name and author of the new cookbook in the boxes to the right of Enter a 
new item and click the + Add New button.  

• To rename a cookbook title or author, click on the name of the cookbook you want to rename, edit the content 
in the boxes to the right of "Select an item from the list", and then click the Rename button.  

• To delete a cookbook, click the red "X" to the right of the applicable cookbook title. Click Save before Close to 
make your changes permanent.  

Click Save before Close to make your changes permanent. 

Note: Only user added cookbooks can be edited or deleted. 
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Edit: RECIPE 

From an individual recipe view, click the Edit button located at the top and bottom of the screen. On the resulting 
Create/Edit Recipe page, enter all new recipe data in the boxes provided and click SAVE to save the changes or 
Save & Close. See Add: CREATE RECIPE. 

Note: If you select a Wiley CulinarE-Companion™ recipe from the individual recipe view and want to add your notes to 
the recipe, click the Edit button, add your comments in My Notes field and click SAVE. If you wish to edit a Wiley 
CulinarE-Companion™ recipe, you must first click the SAVE AS button from the individual recipe view and rename the 
recipe and the author before editing and saving the recipe with the new recipe data. 

Edit: SHOPPING LIST (INDIVIDUAL) 

To edit a shopping list, select the SHOPPING LIST tab. On the resulting Shopping Lists page, click the shopping list 
you would like to edit. On the resulting page:  

• To add a recipe to a shopping list, see Add: RECIPE TO A SHOPPING LIST.  
• To rescale a recipe already included in a shopping list, enter the value in the Rescale if Needed box.  
• To adjust the quantity to purchase, add the quantity desired in the Adjust Quantity field.  
• To add an additional ingredient or recipe to your shopping list, see Add: SHOPPING LIST ITEM.  
• To delete all of the ingredients from an included recipe, see Delete: RECIPE (FROM SHOPPING LIST).  
• To rename your shopping list, click Rename and enter a new title. Make sure to click the Save button to make 

your selections permanent.  

EXPORT 

Export: RECIPE 

There are two ways to export a recipe to another location on your computer:  

1. From the Recipe List page, check the box(es) next to the desired recipe(s), then click the Export button 
located at the top and bottom of the page; or  

2. From the individual recipe view, click the Export button located at the top and bottom of the page.  

On the resulting page, select the desired format for the exported file (.zip, .pdf, .xls) and the recipe components you 
would like to include. When finished, click the Export button. 

Export: SHOPPING LIST 

There are two ways to export a shopping list to another location on your computer:  

1. Click on the SHOPPING LIST tab. From the main Shopping Lists screen, check the box(es) next to the 
desired list(s) and then click the Export button located at the top and bottom of the page; or  

2. From the individual shopping list screen, click the Export button located at the top and bottom of the page.  

On the resulting pop-up screen, select the desired format for the exported file (.xls, .rtf or .zip). When finished, click the 
Export button. 

PRINT 

Print: RECIPE 

There are two ways to print recipes:  

1. From the Recipe List view, check the box(es) next to the desired recipe(s) and then click the Print button 
located at the upper right or lower right hand corner of the page. See VIEW: RECIPE - LISTS.; or  

2. From the individual recipe view, click the Print button located at the upper right or lower right hand corner of the 
page. See View: RECIPE - INDIVIDUAL.  
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On the resulting pop-up screen, select the desired page setup format (full page/portrait, full page/landscape, 3x5 card, 
4x6 card), layout options (Culinary, Foodservice) and the recipe components (Notes, Variations, Nutritional Analysis, 
Photos/Images, Sub Recipes) you would like to include. When finished, click the Print button. 

Note: In order to print recipes, you must have Adobe Acrobat Reader. Go to www.adobe.com/downloads, to obtain a free 
download of this software. 

Print: SHOPPING LIST 

To print a shopping list:  
When viewing an individual shopping list, click the Print button. The shopping list will print as a PDF file. 

Note: In order to print a shopping list, you must have Adobe Acrobat Reader. Go to www.adobe.com/downloads to obtain a 
free download of this software. 

VIEW 
View: BAKER'S % 

 

Baker's % is a method of calculating baking ingredients as a ratio in terms of the weight of a recipe's base ingredient 
(often it is flour). Baker's Percentage is not the same as True Percent. In True Percent, the total of the ingredients 
always adds up to 100%. In Baker's Percentage, the weight of the base ingredient (usually flour) in the formula equals 
100%. All the other ingredients are calculated in proportion to the weight of flour. The mathematical equation is as 
follows: (Weight of ingredient/weight of total flour) x 100 = ingredient %. 

To view the Baker's %, under the Portion and Yield information, check the box labeled Show Baker's %. 

 

To see more about a recipe, See About: RECIPE DETAILS. 

View: CLASSIFY THIS RECIPE CLASSIFICATIONS 

There are two ways to view the master list of advanced search/refine classifications included in the Wiley CulinarE-
Companion™ program:  

1. Click Advanced search from the HOME page, Recipe List page, or Recipe Details page; or  
2. When viewing an individual recipe, click the Classify This Recipe tab.  

To view a recipe's assigned classifications, when viewing an individual recipe, click Classify This Recipe tab. 
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View: COOKBOOKS (ALL) 

There are three ways to view a list of all cookbooks saved to Wiley CulinarE-Companion™:  

1. Click the Preferences link located on the upper right hand corner of each page;  
2. Click the View All Cookbooks link on the HOME page; or  
3. Use the pull-down menu under Browse Recipes on the Recipe List or an individual Recipe Details page.  

View: INGREDIENTS (DATABASE) 

To view an alphabetical listing of all ingredients included in the Wiley CulinarE-Companion™ database, under the 
RECIPES tab, click Ingredient List. You can enter an ingredient name in the search box or select a letter of the 
alphabet to refine your search. Once you click an ingredient, either the USDA information about this ingredient will be 
displayed or the information that you may have added on your own. If you added a new ingredient and did not include 
nutritional information, you can click the USDA Nutrient Data Laboratory link to search for a close match and choose to add 
this information on your own. 

View: INGREDIENTS (RECIPE) 

See View: RECIPE - INDIVIDUAL. 

View: NUTRITION DATA (FOR INGREDIENT) 

See View: INGREDIENTS. 

View: NUTRITION DATA (FOR RECIPE) 

When viewing an individual recipe, click the Nutrition tab. 

View: RECENTLY VIEWED RECIPES 

All Recently Viewed Recipes are listed on the HOME page. 

View: RECIPE DETAILS 

There are 4 ways to view an individual Recipe Details:  

1. From the HOME page under Recently Viewed Recipes, click the desired recipe;  
2. From the Recipe List, click the desired recipe;  
3. On the Recipe List page, check the box(es) of the recipe(s) you wish to view. Click the Open button;  
4. Use the Search or Advanced search function to find the recipe for which you are looking.  

The Recipe Details tab includes ingredients and procedures grouped in their appropriate Stages. To navigate 
between open recipes, click on the previous recipe or next recipe link located at the upper left and bottom left hand 
side of the page. Click back to recipes list to return All Recipes. 

View: RECIPE LISTS 

From the Recipe List page under the RECIPES tab, you may look at any list of recipes saved to the Wiley CulinarE-
Companion™ application. From the pull-down menu located beneath Browse recipes: click View All Recipes, the 
name of a specific cookbook, My Cookbooks, My Recipes, or Unassigned Recipes and the desired list will appear 
on the Recipe List page. You can then browse the recipes alphabetically or by cookbook, author, or date updated. You 
may also refine the list by using the Refine function or clicking on a letter of the alphabet. 

View: RECIPE - INDIVIDUAL 

From the RECIPES tab, select a cookbook or other recipe list from the pull-down menu located under Browse recipes. 
Scroll down the resulting recipe list and then click on the name of the recipe you wish to view.  



CulinarE-Companion™ Help 

Copyright © 2012 by John Wiley & Sons, Inc. All Rights Reserved. 21 

To view two or more recipes: From the RECIPES tab, select a cookbook or other recipe list from the pull-down menu 
located under Browse recipes. Scroll down the resulting list and click on the check box next to the desired recipes. 
When finished click on the OPEN button located at the top or bottom of the recipe list screen. To navigate between 
open recipes, click on the previous recipe or next recipe link located at the upper left and bottom left hand side of the 
page. Click back to recipes list to return All Recipes.  

View: SHOPPING LISTS 

Click the SHOPPING LIST tab. On the resulting Shopping Lists page, click the name of the shopping list you would like 
to view.  

• To add an existing ingredient from the database to the shopping list, enter the ingredient name in "Add Item 
from Ingredient List" field. When you select an ingredient from the list presented, it will be automatically 
added to the shopping list with an "x" in the "Exclude" column.  

• To add an ingredient that is not in the CulinarE-Companion database, enter the name into the "Add Custom 
Item" field and click the "+Add" button. This ingredient will appear in your shopping list with an "x" in the 
"Exclude" column.  

• To rescale a recipe in your shopping list, use the links labeled "Full," "Double," or "Halve" or enter a value of 
your own on the line below, and click Save.  

• To change the amount of an ingredient in your shopping list, add the desired amount in the "Adjust Quantity" 
field to the right of the list and click Save. Note that this will be the value that appears in the Print or Export 
version of the Shopping list, not the quantity that was in the "Amount Needed" column.  

• To delete an item from your list, click the "Exclude" button and click Save. This item will not appear on the list 
when you print or export the Shopping List.  

View: TECHNIQUE VIDEOS 

There are 4 ways to view Technique Videos:  

1. From the HOME Page, you can click on My Videos, or View All Videos to access each of these video 
libraries.  

2. Under the SKILLS tab, click on Technique Video Library and select any technique video title and a video 
player will appear in a separate window.  

3. Under the MY FILES tab, click on the VIDEOS tab to view videos that you have uploaded.  
4. When viewing recipes in the Recipe List, if there is a video camera icon , this indicates that there is a video 

that accompanies the recipe. Open the recipe and click the VIDEOS tab to access the video.  

Browse: RECIPES 

From the Recipe List page under the RECIPES tab, you may look at any recipe list saved to the Wiley CulinarE-
Companion™ application. From the pull-down menu located beneath Browse recipes: click View All Recipes, the 
name of a specific cookbook, My Cookbooks, My Recipes, or Unassigned Recipes and the desired list will appear 
on the Recipe List page. You can then browse the recipes alphabetically or by cookbook, author or date updated. You 
may also refine the list by using the Refine function or clicking on one of the letters of the alphabet. 

Email: RECIPE 

From the individual recipe view, click the Email button located at the upper right and lower right hand corner of the 
page. The Wiley CulinarE-Companion™ program creates a .zip file of the recipe (and images, if any) to attach to an 
email message. Due to system security issues, the program does not attach the .zip file automatically to an e-mail 
message. You will need to open your e-mail application, find the .zip file on your hard drive, and attach the file to your 
message. See View: RECIPE - INDIVIDUAL. 

Note: If you are using Internet Explorer, you will be asked where to save the zip file. If you are using Firefox, you may 
adjust where to save this file (Tools -> Options -> General -> Downloads). 
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Import: RECIPE 

In order to import a recipe into Wiley CulinarE-Companion™, the recipe must be in an acceptable format. You can 
import recipes exported from another Wiley CulinarE-Companion™ application (.zip) (See Export: RECIPE.) or from 
Mastercook software (.mx2). 

To import a .zip file, select the Import Recipe File link under the RECIPES tab and click the IMPORT RECIPE button 
to locate the file you wish to upload. Once a file is selected, the imported recipes from the .zip file will be located under 
the MY FILES tab. (See Export: RECIPE to learn about to export your Wiley CulinarE-Companion™ file.) These recipes 
will also be accessible in your My Recipes cookbook. 

To import a .mx2 file (Mastercook file), select the Import Recipe File link under the RECIPES tab and click the 
IMPORT RECIPE button to locate the file you wish to upload. Once a file is selected, the imported recipes from the 
.mx2 file will be located under the MY FILES tab under My Files. These recipes will also accessible when you click on 
the My Recipes link on the HOME page. 

To import multiple .MX2 files (MasterCook files), first export your .MX2 files from the MasterCook software following 
MasterCook's instructions, then locate the Mastercook .ZIP file on your computer and follow the above instructions. 

Open: RECIPE 

There are 4 ways to open an individual recipe's Recipe Details:  

1. From the HOME page under Recently Viewed Recipes, click the desired recipe;  
2. From the Recipe List, click the desired recipe;  
3. On the Recipe List page, check the box(es) of the recipe(s) you wish to view. Click the Open button; or  
4. Use the Search or Advanced search function to find the recipe for which you are looking.  

Search: RECIPES 

There are three ways to search for Recipes:  

1. From the HOME page, the Recipe List page, or a Recipe Details page, type a keyword - recipe name, main 
ingredient, etc. - in the Search recipes box. You may narrow the search by selecting the cookbook from which 
you wish to search from the pull-down menu in the adjacent box. Then click . Your search results will 
appear on a Recipe Listpage.  

 

2. If you would like to conduct a more refined search, from the HOME page and from any page on which the 
RECIPES tab is visible, click the Advanced search link. You may choose to enter a key word or merely select 
a group of categories to narrow your search. When you are finished detailing your search, click the Search 
button.  
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3. From the Recipe List page under the RECIPES tab, search through the alphabetical list of recipes.  

 

USDA 

You can obtain nutrient data for recipe ingredients by visiting the USDA Nutrient Data Laboratory website at 
www.ars.usda.gov/ba/bhnrc/ndl and searching the USDA National Nutrient Database for the information for which you are 
looking. 

 


